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Introduction
Integration Manager for Microsoft Dynamics® GP is a tool designed to help you 
move data quickly and easily between applications, without the need for custom 
programming or extensive knowledge of application databases. You can use this 
manual to become familiar with Integration Manager.

In the Integration Manager Quick Start guide, you use simple tab-delimited text 
files as data sources and Microsoft Dynamics GP as the destination, but you are not 
limited to this kind of integration. You can combine many source and destination 
adapters to create integrations that meet your needs. Regardless of which 
combinations of sources and destinations you eventually use, the steps to building 
and running integrations are basically the same.

Regardless of whether you’ve used other integration tools or you’re new to 
integration technology, you can use this manual to familiarize yourself with 
Integration Manager.

This introduction includes the following information:

• What’s in this manual
• Prerequisites
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is a hands-on learning tool that you can use to become familiar with 
Integration Manager. If you have used other data integration tools, use this manual 
to understand how Integration Manager handles integrations. 

This manual shows you how to create an integration that extracts data from an 
ODBC/text source and integrates it into Microsoft Dynamics GP. 

To view information about the release of Integration Manager that you’re using and 
which adapters are installed, choose Help > About Integration Manager.

The manual is divided into the following parts:

• Part 1, Getting started, explains how to start Integration Manager and discusses 
the terminology used in the integration process.

• Part 2, Building integrations, describes the steps used to create an integration 
that extracts data from an ODBC/text source and integrates it into the general 

Basic steps for creating integrations

Step 1 Open a new integration.

Step 2 Add a source.

Step 3 Set source properties or establish query relationships, depending on which source 
adapter you are using.

Step 4 Add a destination (and provide destination settings if the adapter requires them).

Step 5 Map the source data to the destination.

Step 6 Run the integration.
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ledger for Microsoft Dynamics GP. By working through the steps, you gain a 
basic understanding of Integration Manager.

• Part 3, Running an integration, explains how to prepare to run the integration, 
as well as how to run it and verify the results.

After you are familiar with the steps presented in this manual, you can continue to 
the Integration Manager User’s Guide, which provides detailed information about 
Integration Manager and the adapters.

Prerequisites

This manual makes the following assumptions.

• You are familiar with the Microsoft Dynamics GP application. 

• Knowledge of integration products and experience working with data in 
tabular format is helpful, but it is not essential to perform the tasks discussed in 
this manual.

• You are using the Microsoft Dynamics GP sample company. If you are not using 
the sample company, the sample data files might not be in the correct format 
and might not work with your company without modification. You can modify 
the structure in the text files by opening these files in a text editor, such as 
Notepad.

• Integration Manager is already installed. Because the tasks are arranged in 
sequential order, it’s important that you perform the tasks in the order they are 
presented.

This manual uses the GLHEADER.txt and GLLINE.txt sample files. Before you 
begin, be sure these files exist in the Samples folder, usually located in C:\Program 
Files\Microsoft Dynamics\Integration Manager\Samples. If you cannot locate the 
sample files at this location, browse to the location where Integration Manager was 
installed. If you still cannot find these files, contact your system administrator or 
Microsoft Dynamics GP Technical Support.

General Ledger is a module included with Microsoft Dynamics GP. This manual uses a 
General Ledger integration as an example of an integration source and destination.

Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts, and 
suggestions.

The warning symbol indicates situations you should be especially 
aware of when completing tasks.
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This manual uses the following conventions to refer to sections, navigation, and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. In the navigation pane for 
the Microsoft Dynamics GP home page, choose User Preferences and then choose 
Display.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in a 
window. This example directs you to go to the File menu and choose 
Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Documentation and resources on the web
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com


6 I N T E G R A T I O N  M A N A G E R  Q U I C K  S T A R T



P
A

R
T

 1
: G

E
T

T
IN

G
 S

T
A

R
T

E
D



8 I N T E G R A T I O N  M A N A G E R  Q U I C K  S T A R T

Part 1: Getting started
This part explains how to start Integration Manager and discusses the basic 
terminology used in the integration process.

The information is divided into the following chapters:

• Chapter 1, “Starting Integration Manager,” describes how to start Integration 
Manager, describes the Integration Manager main window, and introduces the 
menu commands and toolbar buttons.

• Chapter 2, “Common terminology,” introduces the terminology used in 
Integration Manager.
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Chapter 1: Starting Integration Manager
As soon as you have installed Integration Manager, you can begin using it. This 
chapter explains how to start Integration Manager and describes the components 
that make up the Integration Manager main window.

This chapter includes the following information:

• Starting Integration Manager
• The Integration Manager toolbar
• Shortcut keys
• The Integration Manager menus

Starting Integration Manager

You can start Integration Manager from the Start menu or from within Microsoft 
Dynamics GP.

• From the task bar, choose Start > All Programs > Microsoft Dynamics > 
Integration Manager > Integration Manager. 

• From within Microsoft Dynamics GP, choose Tools > Integrate > Integration 
Manager.

If you do not have a default Integration Manager database, the Select Database window 
opens. Use this window to select the database you want to open. You also can mark the 
Set as default database option.

The main Integration Manager workspace opens for the sample database. You can 
change the database from the sample database to your company database by 
selecting it from the Tools > Options menu in Integration Manager. Before you can 
use an existing database in Integration Manager 2013, you’ll need to convert your 
database to version 2013. Refer to the Integration Manager User’s Guide for more 
information.

The buttons in the window become available only after you choose to create a new 
integration or open an existing one.
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You perform all Integration Manager tasks in the main workspace. From this 
workspace, you can access the following:

Toolbar The Integration Manager toolbar consists of buttons for commonly 
used commands in Integration Manager.

Menus The menus include the commands available in Integration Manager. 

The Integration Manager toolbar

The Integration Manager toolbar appears in the upper portion of the main window. 
Each button that appears on the toolbar represents an action you can perform in 
Integration Manager. The following table lists the buttons in the toolbar.

Button Description

Creates a new integration.

Opens an existing integration.

Prints information about the integration.

Saves the current integration.

Displays the properties for an integration, source, or destination.

Opens the Object Browser.

Opens the Add Source window, where you select a source for the current 
integration. The sources you can add depends on the adapters you have 
installed. If you do not have any adapters installed, you still can add an ODBC 
or text source.

Opens the Relationships window, where you create relationships between text 
or ODBC source queries.

Opens the Add Destination window, from which you select the destination for 
the current integration. The destination you can add depends on which 
adapters you have installed.

Opens the Integration Mapping window.

Runs the current integration.
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Shortcut keys

Shortcut keys, also known as accelerator keys, are used with the CTRL key for menu 
commands that are used often. Not all menu commands have an accelerator key.

The following table contains a list of the shortcut keys for commonly used menu 
commands

Menu command Shortcut key

File Open Database CTRL+D

New Integration CTRL+N

Open Integration CTRL+O

Save Integration CTRL+S

Print CTRL+P

View Relationships CTRL+L

Integration Add Source CTRL+A

Add Destination CTRL+D

Mapping CTRL+M

Run CTRL+R
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The Integration Manager menus

The following table lists the commands that are available in Integration Manager. It 
also lists the access keys corresponding to the commands.

Menu commands Description Access key

File menu New Integration Creates a new integration. ALT+F+N

Open Integration Opens an existing integration. ALT+F+O

Close Integration Closes the current integration. ALT+F+C

New Integration 
Group

Creates a new integration group. ALT+F+G

Open Integration 
Group

Opens an existing integration group. ALT+F+R

Save Integration Saves the current integration. ALT+F+S

Import Integrations Imports integrations from other 
Integration Manager databases.

ALT+F+I

Export Integrations Exports integrations to existing 
Integration Manager database files. You 
also can create a new Integration 
Manager database file for the 
integrations you export.

ALT+F+E

Print Prints a report of the integration. ALT+F+P

Exit Exits the current session of Integration 
Manager.

ALT+F+X

Edit menu Remove Script In the Integration Mapping window, 
removes the script associated with a field.

ALT+E+S

Remove 
Translation

In the Integration Mapping window, 
removes the translation associated with a 
field.

ALT+E+T

View menu Relationships Opens the Relationships windows, in 
which you create the relationship 
between the text or ODBC source queries 
used for the current integration.

CTRL+L

Properties Displays the properties of the integration, 
selected source or destination.

Integration 
menu

Add Source Adds a source to the current integration. ALT+I+A

Add Destination Adds a destination for the current 
integration.

ALT+I+D

Remove Removes the selected source or 
destination from the current integration.

Mapping Opens the Integration Mapping window 
for the current integration.

ALT+I+M

Source Settings Opens the Source Settings window, 
allowing you to specify connection 
information for the source adapters that 
require these settings.

ALT+I+U

Destination 
Settings

Opens the Destination Settings window, 
allowing you to specify connection 
information for destination adapters that 
require these settings.

ALT+I+S

Run Runs the current integration. ALT+I+R

Properties Displays the properties of the integration. ALT+I+E
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Tools menu Object Browser Opens the Object Browser window. ALT+T+O

Registration Allows you to register Integration 
Manager.

ALT+T+R

Options Opens a window from which you can 
change options for Integration Manager, 
such as the location of the Integration 
Manager database or substitute 
pathname translations.

ALT+T+P

Create database Allows you to create a new database to 
use in Integration Manager.

Convert database Allows you to convert your databases 
from previous versions of Integration 
Manager to use with the current version 
of Integration Manager.

Window 
menu

Tile Horizontally Lists all open windows and arranges 
them horizontally.

ALT+W+H

Tile Vertically Lists all open windows and arranges 
them vertically.

ALT+W+V

Cascade Displays all open windows in cascading 
order.

ALT+W+C

Help menu Contents Provides access to the online help for 
Integration Manager.

ALT+H+C

Index Contains help topics from the online help 
for Integration Manager.

ALT+H+I

About This 
Window

Contains help information about the 
window displayed on the screen.

ALT+H+W

About Integration 
Manager

Provides the version, location, and 
description of the installed version of 
Integration Manager and its adapters.

ALT+H+A

Menu commands Description Access key
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Chapter 2: Common terminology
Before you begin using Integration Manager, you should familiarize yourself with 
the terminology used throughout the product to have a better understanding of the 
integration process. 

This chapter includes definitions for the following terms:

• Source
• Source adapters
• Integration Manager engine
• Destination
• Destination adapters
• Destination mappings
• Query
• Query relationship

Source

A source indicates where the information to be integrated comes from. In 
Integration Manager, a source can be anything from a comma- or tab-delimited file, 
to a database such as an Open Database Connectivity (ODBC) source. Sources exist 
independently of the source adapters. Refer to Chapter 4, “Adding sources,” for 
more information.

Source adapters

Source adapters connect to sources, and filter and extract data. The data is passed 
on to the Integration Manager engine for processing. This manual explains how to 
use an ODBC/text source.

Integration Manager engine

Working with the source adapter and destination adapter, the Integration Manager 
engine helps you map and integrate the source data into the destination.

Destination

A destination indicates where you want the processed information to be integrated. 
A destination can be an application or database. Destinations exist independently of 
the destination adapters. Microsoft Dynamics GP is an example of a destination.

Destination adapters

Destination adapters validate data before integrating it to the destination 
application, database, or file. If you do not have a destination adapter installed, you 
won't be able to select a destination. This manual explains how to integrate data 
from an ODBC/text source through the Microsoft Dynamics GP adapter into the 
Microsoft Dynamics GP general ledger.
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Destination mappings

Destination mappings define how source data is mapped to the destination. 
Typically, the information comes from the source you specified, but it also can come 
from a constant value or default value in the destination. The integration mapping 
includes several rules you can use when creating a destination mapping.

Query

A query is a request for information. In Integration Manager, queries are used to 
refer specifically to requests for information from a text file or ODBC source. You 
can create several queries when using ODBC/Text as your source.

Query relationship

When you specify more than one ODBC/text source, you create several queries, as 
well. You need to create a query relationship between these queries. This 
relationship tells Integration Manager how the queries work together during the 
integration. For more information about creating query relationships, refer to 
Chapter 5, “Creating query relationships.”
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Part 2: Building integrations
This part of the manual describes how to build an integration. Each chapter 
contains a detailed step-by-step procedure that you can refer to later when creating 
your own integrations.

This manual uses the GLHEADER.txt and GLLINE.txt sample files. Before you begin, be 
sure these files exist in the Samples folder, usually C:\Program Files\Microsoft 
Dynamics\Integration Manager\Samples. If the Samples folder cannot be located at this 
location, browse to the location where Integration Manager was installed. If you still cannot 
find these files, contact your system administrator or Microsoft Dynamics GP Technical 
Support.

This manual is arranged in sequential order, so it’s important that you go through 
the tasks in the order in which they are discussed. 

The information is divided into the following chapters:

• Chapter 3, “Creating integrations,” discusses integrations and how you create 
them.

• Chapter 4, “Adding sources,” explains how to add sources, which retrieve 
information for the integration.

• Chapter 5, “Creating query relationships,” describes why you need to create 
query relationships and how to create them.

• Chapter 6, “Adding a destination,” explains how to select the destination for 
the integration.

• Chapter 7, “Mapping source data to the destination,” describes how to map the 
source data to the destination.
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Chapter 3: Creating integrations
When you create an integration, you’ll define properties for the integration such as 
a name and description, and how many errors and warnings are allowed. The 
integration is the primary object that manages all the components necessary to 
integrate data into a specified destination.

This chapter includes the following information:

• Creating a new integration

Creating a new integration

You can create new integrations or modify existing integrations. This information 
describes the steps you’ll take to create a new general ledger integration. For 
information about modifying integrations, see the Integration Manager User’s 
Guide.

To create a new integration:
1. Start Integration Manager.

2. From the File menu, choose New Integration.

– or –

On the Integration Manager toolbar, choose New Integration.

The Integration window opens, and then the Properties window opens.

3. Enter an integration name. 

For this tutorial, use GL-GJ Integration, which stands for General Ledger to 
General Journal Integration.

For your own integrations, use any name that helps you identify the integration 
easily.
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4. Enter an integration description, such as General Ledger to General Journal 
Integration.

For your own integrations, describe them so you can easily recognize each integration. 
For example, you might enter the source of the data and its destination or a date.

5. Click OK to close the Properties window.

The name of your integration now appears in the Integration window.

6. From the File menu, choose Save Integration.

You should save the integration immediately after you create it, as well as whenever you 
make any changes to it.

Now, you can add sources to the integration. Refer to Chapter 4, “Adding 
sources,” for more information.
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Chapter 4: Adding sources
This chapter describes how to add sources to your integration, specifically, sources 
that query text files. Before you complete the tasks in this chapter, you must already 
have created an integration using the procedure discussed in Creating a new 
integration on page 19.

This chapter includes the following information:

• Understanding sources
• Removing duplicate sources
• Understanding the source files
• Creating the GL Header query
• Previewing source data
• Creating the GL Line query

Understanding sources

A source indicates where the requested information you are integrating originates. 
In Integration Manager, a source can be a comma- or tab-delimited file, or a 
database such as an ODBC source. Sources exist independently of the source 
adapters; however, the sources you can add to your integration depend on the 
source adapters you have installed. For more information about using the source 
adapters you have installed, refer to the Integration Manager User’s Guide. 

The following table shows several available source adapters and the supported 
functionality. The information in the table isn’t exhaustive but is meant to show 
Integration Manager’s ability to support different source adapters.

Source adapter Supported 
functionality 

Remarks

ODBC/Text Extracts data from 
ODBC/Text sources.

This adapter is always installed with 
Integration Manager.

Integration Manager supports three 
types of ODBC/Text Sources: Text, Simple 
ODBC, and Advanced ODBC. Text 
sources retrieve data from text files. 
Simple ODBC sources retrieve data from 
an ODBC data source. Advanced ODBC 
sources issue SQL statements to retrieve 
information from an ODBC data source.

XML Source Adapter Extracts data from 
XML files.

Using this adapter, you can use 
Integration Manager to create 
integrations that use XML files as source 
data and move them into applications 
that may not support XML.
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If someone on your team already has worked through this Quick Start guide, a 
message similar to the following might be displayed when you add your sources.

To resolve this issue, you can use different names for the sources, or you can remove 
the sources that were previously created. Refer to Removing duplicate sources for 
more information.

Removing duplicate sources

If someone on your team already has worked through this Quick Start guide, a 
message similar to the following might be displayed when you add your sources.

To resolve this issue, you can use different names for the sources, or you can remove 
the sources that were previously created.

Use the following procedure to remove a duplicate source.

To remove duplicate sources:
1. On the toolbar, choose Objects.

– or –

On the Tools menu, choose Object Browser.
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The Object Browser window opens.

2. In the Types pane, expand Source Adapters and then expand ODBC/Text. 
Select Text.

3. In the Objects pane, select GL Line and choose Delete.

4. When the confirmation message appears, asking if you want to delete the 
selected item, choose Yes.

Repeat steps 3 and 4 for GL Header, and then close the Object Browser window.

Understanding the source files

The integration in this guide, the GL-GJ Integration, involves importing two 
transactions into the general ledger. The information for these transactions is found 
in two files, GLHEADER.txt and GLLINE.txt. These files are located in the Samples 
directory where you installed Integration Manager. The following illustrations 
show how the files appear in a text editor.

If you are not using the Microsoft Dynamics GP sam[e company, or if your account format 
structure does not match the account structure in the sample files, the integration cannot 
successfully be completed. You can modify the structure in the text files by opening these 
files in a text editor, such as Notepad.

Tab characters separate
the items in each line.

Tab characters separate
the items in each line.

The first line contains
column names.

The first line contains
column names.
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The two text files actually contain the same information as the following two 
transactions.

The header information for both transactions is contained in the GLHEADER.txt 
file, and that the line items for both transactions are contained in the GLLINE.txt 
file.

You will create the following two queries that retrieve the information from these 
two text files.

GL Header Query This query retrieves data from the GLHEADER.txt file.

GL Line Query This query retrieves data from the GLLINE.txt file.

Refer to Chapter 5, “Creating query relationships,” for information about how to 
create a relationship between the two queries that “reassembles” the information 
back into complete transactions. The complete transactions then can be read by 
Integration Manager. 

Creating the GL Header query

This information describes how to add a text source that queries the data in the 
GLHEADER.txt file.

To create the GL Header query:
1. Open the GL-GJ Integration if it is not already open.

This information is contained in
the GLHEADER.txt file.

This information is contained in
the GLLINE.txt file.

This information is contained in
the GLLINE.txt file.

This information is contained in
the GLHEADER.txt file.
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2. In the Integration window, right-click Sources, and choose Add Source. The 
Add Source window appears. 

3. In the Adapters pane, expand ODBC/Text.

4. Select Text.

5. In the Sources pane, select Define New Text and choose Open.

The Properties window for the text query opens.
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6. Enter a name and description for the source. 

Name GL Header
Description GL Header Query

The name should describe the type of information retrieved by the source.

The description should describe the type of data contained in the source. It 
must be descriptive enough so other Integration Manager users can easily 
identify and use it.

7. Choose the General tab to define the general properties for the query. 

• Select the source file to use for the query by clicking the lookup button on 
the right side of the File field.

Browse to the Samples location where the GLHEADER.txt file is located, 
usually C:\Program Files\Microsoft Dynamics\
Integration Manager\Samples. Select GLHEADER.txt and choose Open. 
The path and file name appear in the File field.

• For Delimiter, select Tab, because the items in the GLHEADER.txt file are 
separated (delimited) by characters. 

• Select First Row Contains Column Names. When you select this option, 
Integration Manager uses the names in the text file when referring to the 
columns. 

When you have finished, the window should look like the following 
illustration.

8. Choose the Columns tab to view columns from the text file.
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If you specified the general properties correctly, the Columns tab displays three 
items under Column Name, as shown in the following illustration.

If three items are not listed in the Column Name list, return to the General tab and 
verify that you have specified the appropriate values. Then return to the Columns tab 
and choose Refresh Columns.

9. Choose OK to close the Properties window. The source is added to the 
integration, as shown in the following illustration.

10. On the toolbar, choose Save to save the integration.

Previewing source data

After you’ve created the query, you should preview the source to verify that the 
correct data is being returned. 

To preview source data:
1. In the Integration window, right-click the new source.

2. On the Shortcut menu, choose Preview <GL Header>. 



P A R T  2 B U I L D I N G  I N T E G R A T I O N S  

28 I N T E G R A T I O N  M A N A G E R  Q U I C K  S T A R T

The Data Viewer window opens.

The illustration shows the Data Viewer window with the values returned by the 
query. These values should look just like those in the GLHEADER.txt file. 

3. Choose Close when you have finished viewing the query results.

Creating the GL Line query

After you have added one source that queries a text file (GLHEADER.txt), you’ll 
add the second source that queries the GLLINE file and then preview it.

To create the GL Line query:
1. Open the GL-GJ Integration if it is not already open.

2. In the Integration window, right-click Sources and choose Add Source. The 
Add Source window appears. 

3. In the Adapters pane, expand ODBC/Text. Select Text.

4. In the Sources pane, select Define New Text and choose Open.

The Properties window for the text query opens.

5. Enter a name and description for the source.

Name GL Line
Description GL Line Query

6. Specify the properties on the General tab.

On the General tab:

• Select the source file to use for the query by clicking the lookup button on 
the right side of the File field.

Browse to the Samples location where the GLLINE.txt file is located, 
usually C:\Program Files\Microsoft Dynamics\
Integration Manager\Samples. Select GLLINE.txt and choose Open. The 
path and file name appears in the File field.

• For Delimiter, select Tab, because the items in the GLLINE.txt file are 
separated (delimited) by characters. 

• Select First Row Contains Column Names. When you select this option, 
Integration Manager uses the names in the text file when referring to the 
columns.
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When you have finished entering information, the window should look like the 
following illustration.

7. Choose the Columns tab to view the columns from the text file.

If you specified the general properties correctly, the Columns tab displays four 
items under Column Name, as shown in the following illustration.

If four items are not listed in the Column Name list, return to the General tab and 
verify that you have specified the appropriate values. Then return to the Columns tab 
and choose Refresh Columns.

8. Choose OK to close the Properties window. The source is added to the 
integration.

9. On the toolbar, choose Save to save the integration. 

A message appears, explaining that you need to create query relationships. You will 
create query relationships in Chapter 5, “Creating query relationships,” so you can 
ignore this message for now.

10. Preview the source following the instructions in Previewing source data on 
page 27.
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The Data Viewer window shows the values returned by the query you have just 
created.

11. Close the Data Viewer window and save the integration.
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Chapter 5: Creating query relationships
When you add more than one source that queries text files or ODBC sources, you 
need to create relationships between the sources. Relationships tell Integration 
Manager how sources work together to retrieve information for the integration. In 
this chapter, you’ll create a relationship between the two text sources you added to 
the GL-GJ Integration.

This chapter includes the following information:

• Creating relationships

Creating relationships

The GL-GJ Integration uses two text sources, so you need to define a query 
relationship. The query relationship you’ll create in this example will link the GL 
Header query to the GL Line query.

To create a query relationship:
1. Open the GL-GJ Integration.

2. On the View menu, choose Relationships.

– or –

In the Integration window, double-click Query Relationships.

The Relationships window opens, showing you the GL Header query, which 
retrieves information from the GLHEADER.txt file, and the GL Line query, 
which retrieves information from the GLLINE.txt file.

3. Draw a line between the corresponding columns in the two queries to define 
the relationship.

In the GL Header window (the master query), click and drag from DocNum to 
DocNum in the GL Line window. Release the mouse button when the text icon 
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appears on your mouse pointer. A line appears that connects these two queries, 
indicating that the relationship has been created.

The GL Header query is considered the master, and the GL Line query is the 
child. Each time Integration Manager reads a row from the GL Header query, it 
should read the corresponding line items from the GL Line query. For example, 
when Integration Manager reads the DocNum row in the GL Header query, it 
also reads the DocNum row in the GL Line query.

4. Choose Close to close the Relationships window. 

All relationships you create are verified. If problems exist, an error message appears. If 
an error appears, open the Relationships window and correct the problem.
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Chapter 6: Adding a destination
This chapter describes how to add a destination to your integration—specifically, a 
Microsoft Dynamics GP destination, General Ledger. You can add a destination at 
any time when you build an integration, but you might want to add it after you add 
the source so that you’ve had a chance to become more familiar with the source 
data.

This chapter includes the following information:

• Understanding destinations
• Adding the Microsoft Dynamics GP destination

Understanding destinations

Destinations define where you want the source data to be integrated. They can be 
other applications, a database, or an XML file. Which destinations you can add to 
your integration depends on which destination adapters you have installed.

For more information about using the destination adapters you have installed, refer 
to the Integration Manager User’s Guide.

The following table describes several destination adapters. The information in the 
table isn’t exhaustive. Instead, it is meant to show Integration Manager’s ability to 
support different destinations.

Adding the Microsoft Dynamics GP destination

This information explains how to add the Microsoft Dynamics GP General Ledger 
destination to your integration.

To add the Microsoft Dynamics GP destination:
1. Open the GL-GJ Integration.

2. On the Integration menu, choose Add Destination. 

– or –

Right-click Destination in the Integration window, and from the menu that 
appears, choose Add Destination.

Destination 
adapter

Supported 
functionality 

Remarks

Microsoft Dynamics 
GP destination 
adapter

Integrates data into 
Microsoft Dynamics GP 
destinations using 
Microsoft Dynamics GP

This adapter includes the following predefined 
destinations: Financial, Payables Management, 
Receivables Management, Sales Order 
Processing, Payroll, Inventory, and Setup.

Microsoft Dynamics 
GP eConnect 
destination adapter

Integrates data into 
Microsoft Dynamics GP 
destinations using 
Microsoft Dynamics GP 
eConnect

This adapter includes the following predefined 
destinations: Customer, Inventory Transaction, 
Inventory Item, Purchasing Order Entry, 
Receivings Transaction Entry, Sales 
Transaction, GL Account, GL Transaction, and 
Shipping Method.
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The Add Destination window opens.

3. Expand the Microsoft Dynamics GP folder and choose Financial. 

4. In the Destinations pane, select General Journal and choose Open. 

The General Journal is added as the destination of the integration, as shown in 
the following illustration.

5. On the File menu, choose Save Integration to save the integration.
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Chapter 7: Mapping source data to the 
destination
Before completing the tasks presented in this chapter, be sure that you have created 
the queries for the integration, set up the relationship between the two queries, and 
selected General Journal as the integration destination. These tasks are described in 
the preceding chapters.

This chapter includes the following information:

• Using the Integration Mapping window
• Mapping fields
• Mapping line items for the transaction
• Setting options for the General Journal destination

Using the Integration Mapping window

Destination mappings describe how Integration Manager should map source data 
to the appropriate fields in the destination. Although many values come from the 
source, values also can come from constant values or default values and are defined 
in the Integration Mapping window.

To use the Integration Mapping window:
1. Open the GL-GJ Integration.

2. On the Integration menu, choose Mapping. 

– or –

In the Integration window, double-click Destination Mapping.

The Integration Mapping window opens.

A mapping is composed of rules, which define where the information for an 
item in the destination originates. Several rules are available in Integration 
Manager. For more information on rules, refer to the Integration Manager 
User’s Guide.
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Mapping fields

Based on the destination you select, Integration Manager maps and sets rules for 
several fields, which you can change. In this information, you will map the fields in 
the root recordset labeled General Journal. Specifically, you will change the rules for 
and mapping of the Batch ID, Reference, and Transaction fields.

To map the fields:
1. In the Integration Mapping window, click in the Rule column for the Batch ID 

field. Click the drop-down arrow. From the list that appears, choose Use 
Constant.

Each transaction integrated into the destination is assigned to the batch 
indicated by the value in the Batch ID field. For the GL-GJ Integration, a 
constant value is being used for the batch ID.

2. To set the constant value for the Batch ID field, click in the Source column and 
enter SAMPLE BATCH (in uppercase characters).

– or –

In the Rule Properties section of the window, click in the Value column for 
Constant Value and enter SAMPLE BATCH (in uppercase characters).

For the Reference field, note that Integration Manager sets the rule to Use Source 
Field. This rule indicates that the information comes from one of the text source files for 
the integration. This rule is appropriate for this example, so do not change it. 

3. To map the Reference field, click in the Source column. A lookup button 
appears. Click that button to open the Source Object window.

If the button does not appear, click in another field and then click in the Source column 
for the Reference field again.

4. In the Source Object window, select the GL Header source from the list. Select 
Reference, and then choose Select.

In the Integration Mapping window, “Reference” appears in the Source 
column.



I N T E G R A T I O N  M A N A G E R  Q U I C K  S T A R T 37

C H A P T E R  7    M A P P I N G  S O U R C E  D A T A  T O  T H E  D E S T I N A T I O N

5. Set the rule for Transaction Date to Use Source Field, and then click the lookup 
button in the Source column.

6. Because the value for Transaction Date will come from the Date field in the GL 
Header source file, make the following selections in the Source Object window:

Source GL Header
Column Date

7. Choose Select. 

The Integration Mapping window should look like the following.

Mapping line items for the transaction

In the upper–left pane of the Integration Mapping window, the child recordsets sit 
below the root recordset, which is General Journal for this integration. To map the 
fields in the child recordsets, select the appropriate child recordset in this pane; the 
fields for the recordset appear to the right. For this task, you will map the line items 
that are part of the Entries child recordset.



P A R T  2 B U I L D I N G  I N T E G R A T I O N S  

38 I N T E G R A T I O N  M A N A G E R  Q U I C K  S T A R T

To map the line items for the transaction:
1. Select Entries in the upper-left pane of the Integration Mapping window. The 

fields for this recordset appear.

2. For the Account Number field, be sure the rule is set to Use Source Field. Click 
in the Source column, then click the lookup button. 

The Source Object window opens. 

3. Make the following selections:

Query GL Line
Column Account Num

In order for the lookup button to appear, you may need to click in the Rule column and 
then in the Source column.

4. Choose Select.

The line items for the GL-GJ Integration contain only one amount per line. 
Some of the transaction amounts are positive, while others are negative. 
Positive values are intended to be debit values, while negative values are 
intended to be credit values.

Each entry in Integration Manager requires a debit entry and a credit entry. 
Integration Manager is capable of using a single value for both fields by using 
two special rules: Use Positive Source Field and Use Negative Source Field.

5. For the Debit Amount field, set the rule to Use Positive Source Field. This 
means positive values are imported as they are, while any negative values are 
imported with a value of zero.

6. For the Debit Amount field, click the lookup button in the Source column to 
display the Source Object window. Make the following selections, and then 
choose Select.

Query GL Line
Column Amount
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7. For the Credit Amount field, set the Rule column to Use Negative Source 
Field. This means that you are importing negative values which are designated 
as a corresponding credit amount.

8. For the Credit Amount field, click the lookup button in the Source column to 
display the Source Object window. Make the following selections, and then 
choose Select and Close.

Query GL Line
Column Amount

The Integration Mapping window should now look similar to the following.

Setting options for the General Journal destination

At the beginning of this lesson, you specified that a constant value is used as the 
batch ID for this set of transactions. Now you need to create the batch. A special 
option for the General Journal destination allows you to do this.
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To set options for the General Journal destination:
1. In the Integration Mapping window, select the General Journal item in the 

upper-left pane of the window.

2. Choose the Options tab.

3. Set the rule for the Missing Batch option to Add New Batch.

The new batch is created based on the value you supplied for the Batch ID field 
on the Fields tab.

4. Close the Integration Mapping window.

5. On the File menu, choose Save Integration to save the integration.
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Part 3: Running an integration
This part of the manual describes how to run an integration, and how to verify the 
results. Each chapter contains a step-by-step procedure that you can refer to later 
when creating your own integrations.

The information is divided into the following chapters:

• Chapter 8, “Running the integration,” describes how to run an integration after 
it has been created.

• Chapter 9, “Verifying the results,” explains how to verify the results of the GL-
GJ Integration after running it.
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Chapter 8: Running the integration
This chapter describes how to run the GL-GJ Integration you created, and discusses 
the information you should be aware of before running an integration.

This chapter includes the following information:

• Preparing to run the integration
• Running the integration

Preparing to run the integration

Before running the GL-GJ Integration, you must specify the remaining integration 
properties. You can open the Properties window for an integration by 
double-clicking on the integration.

To prepare to run the Integration:
1. Open the GL-GJ Integration, if it is not already open.

2. Open the Properties window for the integration.
Choose Integration > GL-GJ Integration Properties or right-click the 
integration and choose GL-GJ Integration Properties.

3. In the Destination Edit Mode field, select Insert Only.

Insert Only is the only option available for Journal and Transaction destinations.

The destination edit mode indicates how the source data will be integrated into 
the destination. The modes you can select depend on the destination. When you 
first create an integration, the only available destination edit mode is Insert 
Only, which is the default value. 
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The following table describes the destination edit modes.

4. Enter 10 in both the Maximum Number of Errors and Maximum Number of 
Warnings fields.

These settings represent the maximum number of errors and warnings that 
occur before an integration is automatically stopped.

When an error occurs, typically because of a condition in the data that’s not 
valid, the document fails to integrate. When a warning occurs, the document 
does integrate, but Integration Manager provides information about the 
problem so you can resolve it.

Although this integration doesn’t use them, you can add Microsoft Visual Basic® 
Scripting Edition (VBScript) scripts to an integration using the Scripts tab. The 
scripts are executed at various points during the integration. For more information 
about adding scripts, refer to the Integration Manager User’s Guide.

5. Choose the Logs tab to specify the level of detail to be shown for the log and the 
location of the log files created by Integration Manager.

Logs can be stored either in a text file or in the same Microsoft Access® database 
file that stores integrations. Storing the log in the Access database file allows it 
to be available to all users of Integration Manager in a network environment. 
See the Integration Manager User’s Guide for more information about 
removing log files and compacting the database.

If you store the log in a text file, you need to specify the directory that will 
contain the log. By default, text file logs are stored in the Logs directory located 
where you installed Integration Manager.

6. Choose OK to save the log properties and close the window. 

Mode Description

Insert Only Creates only new records during the integration. Existing records cannot 
be updated.

Update Only Updates existing records during the integration. New records cannot be 
created.

Insert and 
Update

Creates new records and updates existing records during the integration.
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For more information on logs, refer to the Integration Manager User’s Guide.

7. Choose File > Save Integration to save the integration.

Running the integration

After you have made final specifications for the integration, you are ready to run 
the integration. When you run the integration, your data is integrated from the 
source to the destination specified in the integration.

To be sure that users have the correct permissions to run an integration, you must use the 
appropriate user privileges when you run the integration for the first time. Typically, this 
means being part of the Administrators group or the Power Users group on Windows® XP. 
On Windows Vista® , Windows 7, or Windows Server® 2008, it means running the 
integration with administrative privileges. For example, you can run the integration from 
the shortcut on the Start menu, select Microsoft Dynamics > Integration Manager and 
right-click Run Integration, and then select Run as Administrator. Refer to your 
operating system’s documentation for more information. When you run as an administrator, 
the registry and other settings are updated so other users can run integrations without 
permission issues.

To run the integration:
1. Because you are using the Microsoft Dynamics GP adapter, you must open the 

Microsoft Dynamics GP application.

2. Start Integration Manager and open the GL-GJ Integration.

Running an integration requires that Integration Manager is registered. If you do not 
have registration keys, you cannot run an integration. To register Integration Manager, 
see the Integration Manager User’s Guide.

3. On the Integration menu, choose Run. 

The integration begins, and the Progress window opens. This window indicates 
progress as items are read by the integration.

If you set up the integration properly, two documents should be queried and 
successfully imported with no warnings or errors. 
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If there are any errors or warnings, check the following items:

• Be sure the queries are set up and are returning the proper data.

• Verify that the query relationship is set up correctly.

• Check the destination mapping to be sure you have mapped all of the fields 
correctly.

4. Choose Close to close the Progress window.
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Chapter 9: Verifying the results
After you have completed the GL-GJ Integration and it has run successfully without 
any errors or warnings, you can verify whether the data being returned is valid. 
This chapter shows you how to verify the results of the GL-GJ Integration.

This chapter includes the following information:

• Verifying the integration results
• What to do next

Verifying the integration results

You can verify the results of the integration in Microsoft Dynamics GP.

To verify the integration results:
1. Open Microsoft Dynamics GP.

2. Choose Financial > Transactions > Batches to open the Batch Entry window.

3. Click the Batch ID lookup button and select the batch called SAMPLE BATCH. 

4. Choose Transactions to display the transactions that are part of the new batch.
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5. Click the previous record browse button twice to navigate to the first record in 
the batch. 

This should be the first record that was imported by Integration Manager.

The Batch ID, Transaction Date, and Reference fields, and all the line items, 
should match the first sample transaction. Refer to Understanding the source files 
on page 23.

6. Click the next record browse button to display the next record in the batch. 

This record should match the second sample transaction. If both records match, 
you have successfully completed the GL-GJ Integration.

What to do next

Now that you are familiar with the basics of Integration Manager, you can begin 
creating your own integrations. For more information about how to use Integration 
Manager, refer to the Integration Manager User’s Guide. You also can refer to the 
Integration Manager online help for descriptions of each window.

To continue learning Integration Manager using samples, you can use the sample 
files usually located in C:\Program Files\Microsoft Dynamics\Integration 
Manager\Samples. 

The steps you take using the samples may be different from the steps in this manual.
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Glossary
Adapter

An Integration Manager component that 
connects to a destination or source 
application or other data source. 

Advanced ODBC query
A query that issues a SQL statement to 
retrieve information from an ODBC data 
source. See also Simple ODBC query..

Boolean
The logical value true or false.

Comma-delimited file
A text file that uses commas to separate the 
individual data items in the text file.

Collections
See Recordset.

.CSV file
An acronym for Comma-Separated Values. It 
indicates a text file that uses commas to 
separate the individual data items.

Currency
A data type that is intended to hold 
monetary values. It can have up to four 
decimal places and must be in the range –
922,337,203,685,477.5808 to 
922,337,203,685,477.5807.

Data source
An open database communications (ODBC) 
data source from which you want to retrieve 
data.

Data type
A data source setting that indicates what 
type of data is contained in the column of a 
data source. Common data types include 
booleans, currencies, integers and strings.

Delimiter
A character or characters that separate the 
individual data items in a text file. Commas 
and tab characters are often used as 
delimiters.

Destination
Where data gathered by Integration 
Manager is placed in Microsoft Dynamics 
GP. Integration Manager provides several 
common destinations, such as customer 
information or receivables transactions.

Destination adapter
A feature that validates data before 
integrating it to the destination application 
or database such as Microsoft Dynamics GP.

Destination mapping
Where information for each item in the 
integration destination originate. For many 
items in the destination, the destination 
mapping indicates that information 
originates from a query. For other items, the 
mapping indicates that a constant value or a 
default value from Microsoft Dynamics GP 
should be used.

Document definition
The metadata that Integration Manager uses 
to describe the structure and content of a 
source or destination. It describes recordsets, 
hierarchical relationships, fields, data types, 
field lengths, and more. It is analogous to an 
XML schema, but it usually contains more 
information than an XML schema.

Double
A data type that stores a double-precision 
floating point number. The value can have 
up to fifteen significant digits.

Negative values must be in the
range –1.79769313486232E308 to 
–4.94065645841247E–324.

Positive values must be in the
range 4.94065645841247E–324 to 
1.79769313486232E308.

eConnect destination adapter
An Integration Manager denstination 
adapter that enables integration with 
Microsoft Dynamics GP data using 
eConnect.

Enumeration
A data type that is restricted to a fixed set of 
named values. Enumeration fields in a 
destination correspond to list boxes, drop-
down lists and other list controls in 
Microsoft Dynamics GP. When you set the 
value of an enumeration field, you supply 
the integer value that corresponds to one of 
the items in the enumeration. See also 
Translation. 

Filter
Specifies the criteria for determining 
precisely which documents you want to 
extract from the source. You can define filters 
only for those fields located in the Root 
Recordset.

Import command
A command that approximates the structure 
of an XML source that you select and 
converts it into recordsets and fields–a 
structure Integration Manager can use.

Integer
A data type that stores integral numeric 
values. It must be in the range –32,768 to 
32,767.

Integration group
A set of integrations that are performed in 
succession in a specified order.

Integration Manager engine
An Integration Manager component that 
receives data from the source adapter, 
provides mapping and transformation 
functionality, and passes data to a 
destination adapter.

Join
A database operation that combines some or 
all records from two or more tables.

Long integer
A data type that stores integral numeric 
values. It must be in the range
–2,147,483,648 to 2,147,483,647.

LongVarChar
A data type that stores a sequence of up to 
65,535 characters.

Mixed element
Those elements that contain child elements 
to attributes as well as data.

Null
A keyword that indicates a field or variable 
does not contain valid data.

Numeric
A data type specific to Integration Manager. 
It stores decimal values that can have up to 
19 digits with up to 5 of the digits after the 
decimal point.

Query
A request for information. In Integration 
Manager, a query can request information 
from text files or from ODBC data sources.

Query builder
A tool in Integration Manager to aid writing 
a SQL statement to use for an advanced 
ODBC query.

Query relationship
A relationship between two queries that 
defines how they work together to retrieve 
information.

Recordset
An element that is used to map items in an 
integration destination. There are two types 
of recordsets. One type of recordset simply 
groups related fields in the destination. The 
other type of recordset indicates that several 
sets of fields in the recordset can be 
associated with a single instance of a record 
imported into the destination. These 
recordsets are represented by the folder icon. 

Rejection file
A text file that contains records that were 
rejected from text queries by Integration 
Manager. Rejection files have the .rjt 
extension.

Restriction
A set of criteria that allows you to specify the 
rows that will be included in a query. All 
rows that do not fit the criteria are excluded.
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Rule
Defines where the information for an item in 
the destination mapping originate.

Simple ODBC query
A query that retrieves data from an ODBC 
data source. See also Adapter..

Single
A data type that stores a single-precision 
floating point number. The value can have 
up to seven significant digits.

Negative values must be in the range
–3.402823E38 to –1.401298E–45.

Positive values must be in the range 
1.401298E–45 to 3.402823E38.

Source
Indicates where the data to be integrated 
comes from. A source can either be a text file, 
a database, or an application

Source adapter
A feature that connects to a database, text file 
or application source. It filters and extracts 
the data from the source before passing the 
information to the Integration Manager 
engine.

Source data
Shows data from the source one document at 
a time and in the structure of the document 
definition.

Source name
The name of the source document definition 
that you are setting up. This name appears in 
the Add Source window. You may use any 
name that helps you easily identify this 
source document definition.

Source settings
Source settings connect the source document 
definition to an actual source by having you 
specify certain parameters. They are 
additional properties relating to a source and 
are associated with an individual 
integration. They are not, however, 
automatically inherited by other integrations 
that use the same source document 
definition. 

String
A data type that stores a sequence of up to 
255 characters.

Tab-delimited file
A text file that uses tab characters to separate 
the individual data items in the text file.

Text query
A query that retrieves data directly from text 
files.

Translation
Allows you to define a relationship between 
values in the source file and corresponding 
values that are used for the destination field.

VBScript
A subset of the Microsoft Visual Basic® 
programming language that is embedded 
into Integration Manager to provide 
scripting capabilities.

XML
Extensible Markup Language (XML) is the 
standard method of viewing data on the 
Web. Rich, structured data from any 
application can be easily described in a 
standard and consistent manner through the 
use of XML. It also is a complementary 
format of HTML.

XSLT
eXtensible Stylesheet Language for 
Transformations (XSLT) is used as a part of 
XSL, which functions as a stylesheet 
language for XML. XSL includes an XML 
vocabulary for specifying formatting; XSL 
specifies the styling of an XML document by 
using XSLT to describe how the document is 
transformed into another XML document 
that uses the formatting vocabulary.
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Index
A
About Integration Manager, command 13
About this Window, command 13
accelerator keys 10-12
access key

About Integration Manager 13
About this Window 13
Add Destination 12
Add Source 12
Cascade 13
Close Integration 12
Contents 13
Destination Settings 12
Exit 12
Export Integrations 12
Import integrations 12
Index 13
mapping 12
New Integration 12
New Integration Group 12
Object Browser 13
Open Integration 12
Open Integration Group 12
Options 13
Print 12
Properties 12
Registration 13
Remove Script 12
Remove Translation 12
Run 12
Source Settings 12
Tile Horizontally 13
Tile Vertically 13

adapters
destination adapters defined 15
source adapters defined 15

Add Destination
button 10
command 12
shortcut key 11

Add Source
button 10
command 12
shortcut key 11

Add Source window
Adapters pane on 25
Sources pane on 25, 28

adding
a destination 33
a new source 21

available, sources 21

B
button

Add Destination 10
Add Source 10
mapping 10
New Integration 10

button (continued)
Objects 10
Open Integration 10
Print 10
Properties 10
Relationships 10
Run 10
Save 10

C
Cascade, command 13
changes since last release, information 

about 5
Child Recordset

Integration Mapping window for 38
Integration Mapping window for 

completed 39
mapping Fields in the 37

Close Integration, commands 12
commands

About Integration Manager 13
About this Window 13
Add Destination 12
Add Source 12
Cascade 13
Close Integration 12
Contents 13
Defined 10
Destination Settings 12
Exit 12
Export Integrations 12
File 12
Help 13
Import Integrations 12
Index 13
Integration 12
Keyboard shortcuts 12
Mapping 12
New Integration 12
New Integration Group 12
Object Browser 13
Open Integration 12
Open Integration Group 12
Options 13
Print 12
Properties 12
Registration 13
Relationships 12
Remove 12
Remove Script 12
Remove Translation 12
Run 12
Source Settings 12
Tile Horizontally 13
Tile Vertically 13
Tools 13

Contents, command 13
creating

a new integration 19
a query relationship 31
steps to create an integration 2

creating (continued)
the GL Header query 24
the GL Line query 28

D
Data Viewer window, for the GL Header 

query 28
destination adapters

defined 15
Microsoft Dynamics GP 33

Destination Edit Mode 43
destination mappings, defined 16
Destination Settings, command 12
destinations

adding to an integration 33
defined 15
understanding 33

documentation, symbols and conventions 
3

E
engine, Integration Manager engine 

defined 15
errors

Maximum Number of 44
when running integrations 46

Exit, command 12
Export Integrations, command 12

F
Fields

mapping 36
mapping in the Child Recordset 37

File, commands 12

G
GL Header query

Columns tab on Properties window 
for 27

creating 24
defined 24
General tab on Properties window for 

26
Properties window for 25

GL Line query
Columns tab on Properties window 

for 29
creating 28
defined 24
General tab on Properties window for 

29
Properties window for 28

GLHEADER.txt file
defined 24
displayed 23

GLLINE.txt file
defined 24
displayed 23

H
Help, command 13
help, displaying 4
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Help menu, described 4

I
icons, used in manual 3
Import Integrations, command 12
Index, command 13
Integration, command 12
integration

creating a new 19
defined 19
preparing to run an integration 43
running an integration 45
running as an administrator 45
steps to create 2
troubleshooting 46

Integration Manager Engine, defined 15
Integration Manager Main window 9
Integration Mapping window 35

Child Recordset on 38
completed 37
for the Child Recordset completed 39
mapping Fields on 36
opening 35
Options tab on 40
understanding 35

Integration Properties window 43
Integration window 20

L
logs, specifying settings 44
lookup window, displaying 4

M
Main window, using 9
Mapping, button 10
mapping

command 12
Fields 36
Fields in the Child Recordset 37
Fields on the Integration Mapping 

window 36
shortcut key 11

menus, defined 10
Microsoft Dynamics GP adapter defined 

33

N
navigation, symbols used for 3
new features, information about 5
New Integration

button 10
commands 12
shortcut key 11

New Integration Group, commands 12

O
Object Browser

command 13
window, Types pane on 23

Object Browser window, Objects pane on 
23

Objects, button 10

ODBC/Text
defined 21
sources types 21

Open Integration
button 10
commands 12
shortcut key 11

Open Integration Group, commands 12
Options, command 13
options, specifying 39

P
permission issues, integration 45
preparing, to run an integration 43
prerequisites 3
previewing, source data 27
Print

command 12
shortcut key 11

Print button 10
Procedures

creating a new integration 19-20
creating GL Header query 24-27
creating GL Line query 28-??
creating query relationships 31-32
mapping fields 36-37
mapping Fields in the Child 

Recordset 38-39
opening the destination Integration 

Mapping window 35
preparing to run the integration 43-45
previewing source data 27-28
removing source queries 22-23
running an integration 45-46
verifying results 47-48

Properties
button 10
command 12

Properties window
Columns tab on GL Header query 27
Columns tab on GL Line query 29
displaying 19
for GL Header query 25
General tab on GL Header query 26
General tab on GL Line query 29
GL Line query 28

Q
query

creating a relationship 31
defined 16
duplicate source query names 21, 22
GL Header 24
GL Line 28
relationship defined 16

R
Registration, command 13
Relationships

button 10
command 12
shortcut key 11

Relationships window 31, with 
relationship defined 32

Remove, command 12
Remove Script, command 12
Remove Translation, command 12
required fields, described 4
resources, documentation 4
results, verifying 47
Rules, Use Negative Source Rule 35
Run

button 10
command 12
shortcut key 11

running, Integration Manager 9

S
Save button 10
Save Integration, shortcut key 11
shortcut keys 10-12
source

adding a new 21
defined 15, 21
duplicate query names 21, 22
previewing data 27
understanding sample files 23

source adapters, defined 15
Source Object window 36
source sample files 23
Source Settings, command 12
specifying

log settings 44
options 39

starting, Integration Manager 9
symbols, used in manual 3
symbols and conventions, defined 3

T
terminology 15
Tile Horizontally, command 13
Tile Vertically, command 13
Tools, command 13
troubleshooting, integrations 46

U
Use Negative Source Rule 35

V
verifying, results 47

W
warnings

Maximum Number of 44
when running integrations 46

what’s new, accessing 5

X
XML, Source Adapter defined 21
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